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Biro-priprema
1. UPOZNAVANJE SA RAČUNAROM
Računar je mašina koja, u veoma kratkom vremenskom roku, može da obavlja veliki broj operacija. Ne postoji “gluplji” ili “pametniji” računar, već računar koji brže ili sporije obavlja veći ili manji broj računskih operacija.
Računar čine dve osnovne kompomente, a to su:
· HARDWARE (gvožđurija) predstavlja sve metalne, “tvrde” delove računara (kućište, grafičke i zvučne kartice, memorije i sl).
· SOFTWARE (soft - mekan) predstavlja celokupnu programsku strukturu koju ima svaki računar. Postoje dve vrste softvera: sistemski i aplikativni (izvršni). Na primer, Windows je sistemski softver, jer omogućava računaru da radi. MS Office paket programa (Word, Excel itd) istovremeno je i softerski i aplikativni, jer pomoću njega se radi na računaru ali se i obavljaju konkretni zadaci.
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Današnji računari se sastoje od sledećih elemenata:
· monitora
· tastature (Keyboard)
· računara (kućište, ploča, faks modema, memorije, CD Rom i Floppy drive...)
· miš (mouse)
· podloga za miš (mouse pad)
· zvučnici (speakers).
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Osim navedenih elemenata, koji su osnovni, postoje i drugi elementi koji se mogu priključiti na račanar, a to su: štampač, skener, mikrofon itd.
Veličina, dizajn pa i oblik svakog dela računara razlikuju se od proizvođača do proizvođača:
Monitori koji se danas mogu naći na našem tržištu veličine su od 14", 15", 17", 19" do 21" ("-inč engl. mera za dužinu) ili sad najmoderniji LCD monitori sa ravnim ekranom male debljine.
Miševi mogu biti sa dva-tri ili više dugmeta ili tzv. scroll točkićem za listanje fajlova.
Floppy disk drive je uređaj koji čita podatke sa malih disketa od 3,5 " kapaciteta 1,44 Mb.
Kućišta mogu biti: AT, ATX, po veličini Tower (Mini i Midi) ili Desktop kućište.

CD ROM Drive-ovi se međusobno razlikuju po proizvođaču kao i po brzini čitanja zapisa (24 x, 40 x, 52 x ...).
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CD drive	Kućište računara
Merne jedinice koje se koriste u informatici:
U svetu računara postoje određene merne jedinice kojim se određuje veličina memorije (kapacitet diska), brzina rada računara, veličina radne memorije i slično.
Veličina memorije:
Osnovna jedinica je 1 bit (bit).
8 bitova čine 1 bajt (byte).
1024 bajtova čine jedan kilobajt (Kb).
1024 kilobajta čine 1 megabajt (MB).
1024 megabajta čine Gigabajt (Gb).
Brzina rada procesora određuje se u megahercima (MHz). 16 Mhz-16 megaherca, 433 Mhz, 1600 Mhz je 1.6 Ghz (Gigaherc).
Računari mogu imati više vrsta memorije:
RAM - (Random Access Memory) predstavlja tzv. radnu memoriju u kojoj računar preuzima i obrađuje podatke.
ROM - (Read Only Memory) memorija je ona memorija iz koje se podaci mogu samo čitati.
HDD – (Hard Disk Drive), hard disk je mesto na kojem su smešteni svi programi pomoću kojih računar radi.
Floppy Disk – flopi-disk čita zapis sa disketa malog formata kapaciteta 1,44 Mb.

STANDARDNA TASTATURA
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Opis tastera na standardnoj tastaturi:
· TAB - ima višestruku upotrebu. Klikom na pomenuti taster u tekstu počinje novi pasus sa uvučenim prvim redom. Dok se popunjava neki upit, pomoću njega može se kretati po poljima.
· CAPS LOCK (kaps lok) - uključuje/isključuje velika slova
· SHIFT (šift) - u kombinaciji sa drugim tasterom ispisuje se veliko slovo ili neki znak.
· CTRL - u kombinaciji sa drugim tasterom poziva određenu funkciju.
· ENTER (enter) - ima višestruku upotrebu. Pomoću njega u programu Word (vord) može se preći u novi red, može biti potvrda za komandu Ok. U programu Excel (eksel) može biti nova ćelija, znak jednakosti i sl.
· SPACE (spejs) - razmak pri kucanja teksta u vordu.
· ← Backspace (bekspejs)- ovaj taster pomera blinker[footnoteRef:1] nalevo i briše tekst. [1:  BLINKER – mala linija koja trepti (blinka) i iz koje izlaze znakovi pri kucanja teksta; reči koje se koriste u ovoj skripti a  istog su značenja su i flešer, kursor] 

· INSERT (insrt) - ovaj taster uključuje opciju prekucavanja.
· DELETE (dilit) - ovaj taster briše obeleženi deo teksta.
· HOME / END - ovi tasteri pomeraju blinker na početak ili kraj reda. U kombinaciji sa tasterom SHIFT pomeraju blinker na prvu odnosno poslednju stranicu.
· PAGE UP / PAGE DOWN (pejdž ap/pejdž daun) tasteri omugućavaju listanje dokumenta.
· NUM LOCK (num lok) - uključuje / isključuje numerički deo tastature. (VAŽNA NAPOMENA: Uvek treba proverit da li je ovaj deo tastature uključen).
· <— t —► | - strelice kursora omogućavaju kretanje blinkera kroz dokument.
· / * - + - ovi tasteri su matematičke operacije - deljenja, množenja, oduzimanja i sabiranja.


Operativni sistem
2. WINDOWS (vindous)
START
Uključivanjem računara sistem Windows počinje da se "podiže". Na ekranu se pojavi nekoliko ikonica (My Computer, My Documents, Internet Explorer i Recycle Bin).
· Pozadina ekrana se zove – desktop.
· Donja statusna linija – taskbar.
Rad u sistemu Windows pretežno zahteva upotrebu miša, mada se poneke operacije mogu izvesti i pomoću tastature.
Rad pomoću miša
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Desnim tasterom miša poziva se paleta sa funkcijama,
Levim tasterom miša bira se funkcija sa palete i aktivira se.
U daljem tekstu DESNI TASTER MIŠA obeležava se sa DTM, a LEVI TASTER MIŠA sa LTM. Klikom dva puta mišem (dvoklikom) na neku od ikonica na desktopu otvara se željeni dokument.
Desktop
Desktop predstavlja površinu koja se prva vidi nakon „podizanja“ sistema. Na njemu se prvo pojave ikonice koje su istovremeno i „ulaznice“ u sam sistem.
Na desktopu može se otvoriti folder ili napraviti prečica (Shortcut) tako da se odmah sa desktopa ulazi u željeni folder.
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Pritiskom DTM na desktopu se pojavljuje paleta funkcija:
· Active Desktop – podešavanja desktopa
· Arangge Icons – podešavanja ikonica na desktopu u zavisnosti od imena, tip, datuma...
· Paste – kopirani fajl (dokument) „prilepiti“ na desktop,
· New – omogućava otvaranje novog foldera ili novog dokumenta iz ponuđene paleta programa,
· Properties – omogućava podešavanja pozadine desktopa kao i podešavanja opcije Screensaver (skrinsjver). Screensaver opcija štiti monitor i može se podestiti tako da se aktivira u željenom trenutku. 

Taskbar
Donja linija na desktopu zove se taskbar linija. Na njoj se u donjem levom uglu nalazi funkcija START, dok je u desnom uglu vreme, mada mogu da stoje i druge prečice.
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Funkcija taskbara je da omogućava rad sa više programa istovremeno. Kada se otvori neki fajl ili folder (dvoklik LTM-om na ikonicu), pojavljuje se prozor koji pokazuje sadržaj fajla ili foldera. U gornjem redu je paleta funkcija koja omogućava podešavanja foldera.
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U gornjem desnom uglu nalaze se znakovi:

Pritiskom na crticu otvoreni folder se premešta na taskbar i uvek pritiskom na njega na taskbaru može se ponovo aktivirati. Pritiskom na prozor proširuje se prozor, a pritiskom na „iks“ izlazi se iz foldera (ili prečica na tastaturi ALT+F4).

Ako se otvori više foldera istovremeno, svi će biti prikazani na taskbaru.

OPIS FOLDERA (ŠTA JE FOLDER?)
U prethodnim pasusima, opisivani su pojmovi desktop, taskbar i slično, a iako se nije objašnjavao, koristio se i izraz „FOLDER“. Pitanje koje se samo po sebi nameće jeste - ”Šta je folder?”.
„Folder“ u slobodnom prevodu znači ”fascikla”. Uvek je predstavljen ikonicom žuta fascikla i imenom (□). Ono što svaki korisnik računara mora da zna jeste to da se otvaranjem foldera pravi “mesto” u računaru za određeni dokument, odnosno dokumente ili druge foldere (podfoldere).
Folderi se najčešće koriste radi bolje uređenosti arhive, radi lakšeg snalaženja među fajlovima, bržeg nalaženja željenog foldera ili fajla itd.
Vrlo često se folder poredi sa ”fiokom”. Naime, folder u računaru je kao fioka u ormaru, pomaže lakšem, boljem i preglednijem odlaganju dokumenata.

Virtuelna fioka	Folder
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Folder se otvara desnim tasterom miša: Desni taster miša (DTM) > New > Folder. Levim tasterom miša ulazi se u novootvoreni folder. Pojavljuje se veliki beli prozor unutar kojeg se mogu na isti način napraviti novi folderi - potfolderi.
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Na belini velikog prozora može se otvoriti novi folder koji se sada nalazi u glavnom folderu tzv. potfolder (subfolder)
TREE jednog dokumenta (Tree – od engl. drvo).

Klijent 1
Folder TEKOMS

Klijent Klijent 2
Klijent 3

Ugovori
Klijent 4

Fakture
U folderu TEKOMS nalazi se potfolderi Klijent 1, Klijent 2, Klijent 3 i Klijent 4. U folderu Klijent 4 nalaze se potfolderi Ugovori i Fakture. Ostali folderi su prazni, ne sadrže dokumenta.

Važno je zapamtiti - kreiranjem foldera sa potfolderima ne oduzima se nijedan kilobajt memorije računara. Drugim rečima, virtuelna fioka ako nije napunjena, iako postoji, ne troši memoriju računara. Tek unošenjem podataka u folder troši se i memorija računara.


OPIS FUNKCIJA U PALETI
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	Open (Otvori )
	Otvara izabrani folder, dokument

	Send to (Pošalji)
	
Šalje kopiju dokumenta gde se odredi

	Copy ( Kopiraj)
	Preuzima kopiju dokumenta radi kopiranja 

	Create Shortcut (Prečica)
	Najkraći put do dokumenta (prečica)

	Delete (Briši)
	Briše dokument premeštajući ga u folder Recycle Bin 

	Rename (Promeni ime)
	Dodeljuje folderu ili dokumentu drugo ime


	Properties
	Osnovne karakteristike dokumenta 
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Shortcut (prečica) omogućava direktan ulazak u željeni fajl (od engl.–file, u daljem tekstu) bez otvaranja osnovnih foldera. Ikonica sa strelicom u donjem levom uglu predstavlja Shortcut (prečice).
File (fajl) je predstavljen različitim ikonicama, imenom i ekstenzijom. Ekstenzija predstavlja vrstu fajla (Word ima ekstenziju .doc, a Excel .xls itd.)
Primer:
Ako se za folder Hemija napravi prečica na desktopu računara, omogućava se ulazak u navedeni folder bez prethodnog ulaska u Windows Explorer – /NN/Zadaci/Hemija.
Rad u Windowsu počinje od START menija koji se nalazi u levom donjem uglu desktopa. Klikom levog tastera miša na START pojavljuje se paleta funkcija:
Programs	Pokazuje spisak programa koji se nalaze u računaru
Favorites	Spisak linkova (interaktivno mesto koje vodi ka nekoj veb-prezentaciji)
Documents	Spisak poslednjih 15 dokumenta na kojima se radilo
Settings	Omogućava podešavanje i prilagođavanje Windowsa po sopstvenim potrebama
Find	Omogućava pretraživanje fajlova
Help	Pomaže pri rešavanju problema na koje korisnik nailazi tokom rada na računaru
Run	Komanda linija
Turn Off Computer	Računar pokazuje prozor gde se nude opcije isključenja i restartovanja računara (ponovnog podizanja sistema).


Prvi folder
Otvorite svoj folder onako kako je opisano (DTM>New>Folder). Otvorite ga bilo gde u računaru (na prazan deo desktopa ili u folderima My Document ili Windows Explorer). Pošto ste otvorili folder, dajte mu ime po želji (npr. svoje ime ili sadržaj foldera).
Promena imena foldera vrši se DTM>Rename. Ispod foldera koji je markiran pojavljuje se pokazivač kojim se briše postojeći i daje novi naziv. Pritiskom na ENTER folder je preimenovan. DTM kliknite na novi folder. Folder se otvara i pokazuje se veliki prozor koji treba ispuniti fajlovima.
Kopiranje foldera:

Novootvoreni folder sa svim sadržajima može se kopirati u bilo koji drugi folder u računaru. Pritiskom DTM na željeni folder pojavljuje se paleta opcija iz koje se bira COPY. Zatim se klikne desni taster miša na folder u koji treba snimiti prthodno obeležen folder i pojavljuje se paleta opcija iz koje se bira PASTE (prilepi) pritiskom na levi taster miša.
Folder može da se snimi i na flopy disketu (disk A:). Naravno, pre snimanja foldera na disketu treba proverite da li folder može da stane na disketu koja je kapacieta 1.44 MB (DTM>Properties). Ako je folder veći od 1.44 MB, onda ga treba kompresovati (u žargonu se upotrebljava izraz - zipovati) i tako ga snimiti na disketu (prim. "ZIPOVANJE" JE KASNIJE OBRAĐENO).
Snimanje foldera ili fajla na disketu se vrši:
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DTM > Send to > Floppy A:
Folder se može pomerati sa jednog mesta na drugo. Ako su međusobni folderi vidljivi mogu se pomeriti LTM. Prvo se markira fajl a potom držeći sve vreme LTM prevlači se do određenog mesta. Treba znati da i dalje postoji samo jedan primerak foldera, jer opcija MOVE pomera folder na drugo mesto, a ne kopira ga.
Više foldera može se kopirati ili snimati istovremeno.
CTRL+A – bira sve fajlove u folderu CTRL+LTM – bira samo fajlove koji su markirani.
Princip kopiranja je isti COPY – PASTE ili pomeranja.


Kompresovanje ("zipovanje") fajlova
Svaki fajl je određene veličine koja se izražava u kilobajtima.
Najčešći programi koji se upotrebljavaju u takve svrhe su WinZip (razne verzije), WinCommander, WinAce itd.
U zavisnosti od verzije zip programa i samog fajla koji se kompresuje zavisi i kako će biti izvršena i u kojoj meri kompresija.
Zipovanje Winzipom
DTM (markirajte fajl koji zipujete) – Add to Zip (Računar Vas pita gde zipovani file da smesti) – Add
Scan Disk

Skeniranje diska predstavlja rutinski pregled diska i preporučljivo je da se radi često. Računar skenira izabranu površinu diska (disk C, disk A itd ) i traži greške, kvar ili oštećenje. Ako nađe nešto, računar odmah obaveštava o tome kakvo je oštećenje i da li ga treba odmah popravi. Računar „sklanja“ (izoluje) sve kvarove tzv. Bad sectories (sektori koji usporavaju sistem) dalje od "zdravih" sektora diska.
Komanda se poziva: START > Programs > Accessories > System Tools > Scan Disk.
Disk defragmenter

Defragmetacija diska predstavlja rutinski pregled i slaganje sadržaja hard diska.
Drugim rečima, u toku rada na računaru (instaliranje programa, rad sa fajlovima itd) vremenom dolazi do “razbacanosti” određenih fajlova koje glava hard diska teže čita, što se svakako oseća u brzini. Ovom komandom se fajlovi sređuju tako da čitanje postaje brže.
Komanda se poziva: START > Programs > Accessories > System Tools > Disk Defragmenter.


Programski moduli za unos i formiranje teksta 
3. MS WORD (primer)
MS Word se može aktivirati pritiskom na START>Programs>Microsoft Word.
Otvaranjem Worda nailazi se na ekran koji je beo i prazan tj. predstavlja "papir" po kojem se piše. Sam izgled prozora je sličan prozorima koji se pojavljuju pri otvaranju foldera (meni linija, alatke i slično), samo što je veći broj alatki.
Sadržaj naslovnog ekrana u programu Word
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Na naslovnoj liniji se nalazi pored zvanične identifikacije Microsoft Word i ime dokument.


Linija sa menijima:
Na liniji sa menijima se nalaze uglavnom funkcije čiji sam naziv definiše
njihovu upotrebu (Print, Save i sl.) ili funkcije koji formatizuju dokument po želji
(veličinu slova, fonta i sl). Sami nazivi u meniju ukazuju na vrstu funkcije. Pored naziva funkcija u paleti na meniju obično stoji i njihova tastaturna prečica (na primer: New... Ctrl+ N)
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Pre nego što se uopšte počne sa radom u Word–u, potrebno je definisati font odnosno veličinu i izgled slova. Word ima veliku arhivu fontova među kojima se nalaze i razne vrsta slova ćiriličkog ili latiničkog pisma.
U donjem desnom uglu ekrana nalazi se plavi kvadratić u kojem je upisana reč En. Klikom LTM na pomenuti kvadratić računar pokazuje paletu u kojoj su pobrojani jezici (najčešće su u ponudi English, Serbia ili Slovenian), izborom jednog od navedenih jezika tastatura se automatski podešava za rad na tom jeziku.
English reguliše abecedu, Serbian ćirilicu dok je Slovenian rezervisan za latinicu.
Po izboru fonta, veličine slova i pisma počinje se sa radom. Iz crne uspravne linije tzv. flešera počinje da „izlazi“ tekst.
Na donjoj slici je pokazana paleta sa alatkama pomoću kojih se može podesiti vrsta i veličina fonta, položaj teksta u odnosu na marginu, nabrajanje određenih delova teksta brojevima (numbering) ili znakovno (buliti), obojiti pozadinu fonta ili sam font itd.
Markiranje i kopiranje teksta (Copy, Paste)
Veoma važna operacija u programu Word je svakako markiranje teksta, odnosno obeležavanje dela teksta ili celog teksta u dokumentu. Naime, dok se drži LTM, lagano se mišem pređe preko dela teksta koji treba označiti. Dok se prelazi preko slova, polje iza njih postaje crno.
Takav tekst je markiran i SVE ŠTO SE AKTIVIRA SA LINIJE SA ALATKAMA VAŽIĆE SAMO ZA MARKIRANI TEKST.
Na markirani tekst klikne se DTM na paleti, koja se pojavila, izabere se opcija Copy. Zatim, kursorom se dođe na mesto na koje treba markirani tekst kopirati, klikne se opet DTM i izabere opcija Paste. Ranije kopirani tekst sada je prilepljen na željeno mesto.


SNIMANJE DOKUMENTA
Jedna od veoma važnih operacija je svakako čuvanje, odnosno snimanje podataka. Dokument može da se sačuva (snimiti) u memoriji klikom na ikonicu U ili tastarurnom prečicom CTRL+S. Otvara se tzv. Dialog Box u kojem se bira mesto za čuvanje dokumenta.
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Tasteri
Word kao tekst procesor zahteva da glavno komunikaciono sredstvo bude tastatura. Naravno, neke operacije mogu se izvesti mišem, što može usporiti rad.
Sledi spisak nekih tastera ili tastaturnih prečica koje mogu ubrzati unos i pregled teksta.

· Win + E - otvaranje Windows Explorer-a
· Win + D - minimizira sve otvorene prozore
· Win + F - otvara Find dijalog prozor iz START menija
· Win + R - otvara Run dijalog prozor iz START menija
· Win + Tab - prolaz kroz dugmad na taskbaru
· Win + Break - otvara System Properties dijalog prozor
· Shift + Win + M - poništavanje minimiziranja svih razmaknica prozora
Neke tastaturne prečice u MS Word-u

Listaj dokument nagore
Listaj dokument nadole
Prelazak na početnu stranicu
Prelazak na poslednju stranicu
Sva velika slova
Markiranje celog teksta
Copy, kopiraj
Paste, prilepi
Zamasti slova
Iskrivi slova
Podvučena slova
Tab
Shift+<--^^
Štampaj dokument
Undo (opoziv funcije)
Snimi dokument
Spacebar

Page Up
Page Down
CTRL+Home
CTRL+End
CAPS LOCK
CTRL+A
CTRL+C
CRTL+V
CTRL+B
CRTL+I
CTRL+U
Tabulator (Uvučeni pasus)
Fino markiranje teksta
CTRL+P
CRTL+Z
CTRL+S
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FORMAT FONT
Ovom opcijom samo se delimično formatira tekst.
Na primer, ako je potrebno da se napiše m2 (gde je dvojka iznad flešera) ili A1 (gde je 1 indeks) klikom na CTRl+D otvara se prozor opcije Format Font.
Superscript ili Subscript (kucanje formata m2 ili A1)
Klikom    LTM-a    na    neki    od    kvadratića,
pojavljuje se znak [7] koji označava da je
određeni format fonta uključen i da će takav
format biti sve do trenutka dok se ne isključi
ponovnim pozivom na CRTL+D i LTM na znak 0.

FIND AND REPLACE (NAĐI I ZAMENI)
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Ova opcija omogućava korisniku da izvrši pretragu dokumenta prema definisanoj reči i da je zameni nekom drugom. Klikom na CTRL+H poziva se opcija pretrage. LTM u prozor Find what: Upisati koja reč se traži
LTM u prozor Replace itd: Upisati sa čim da se zameni.
NUMERACIJA STRANA (PAGE NUMBERS)
	Page Numbers
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	OK
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Numerisanje strana se poziva na
Insert (linija sa naredbama)>Page numbers.
Klikom na ovu opciju otvara
se prozor u kojem se definiše položaj numeracije stranice.
Klikom na strelice pored reči
Bottom of the page ili Top of the page podešava se položaj  broja (zaglavlju ili podnožju stranice).
Klikom na strelicu pored reči Right podešava se položaj broja (levo, desno, centar itd).

AUTOSAVE, PROTECT DOCUMENT
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Važna opcija pri unosu podataka je svakako
TrackChanges     |     User Information     |    Compatibility     |    File Locations
View     |   General   |      Edit      |     Print	Save      I  Spelling &Grarnmar
čuvanje tih podataka. Ali u toku  kucanja teksta korisnik obično zaboravlja da povremeno sačuva svoje podatke. Računar pamti samo
Save options — |     Always create backup copy l~~ Allow fast saves ~~ Prompt for document propert[es ~~ Prompt to save Normal ternplate |~ Embed TrueType fonts
~"~ Ernbed characters in use only |~~ 5ave data only for forrns I    |Ajlo"A" background savesi ~~~ Save AutoRecover info every:
ono što se snimi klikom na Save.
Svaki naknadni unos teksta, bez snimanja memoriše se kratkoročno i može se izgubiti ukoliko dođe do iznenadnih
prekida struje, pucanja sistema i sl. Klikom
[sr
~j minutes
na Tools (linija sa naredbama) > Options >
Save poziva se opcija uključenja snimanja
5ave Wprd files as:        |Word Document (*.doc) I- Disabje features not supported by Word 97
File sharing options for "MOJ DOKUMENT" —
dokumenta u vremenskim intervalima.
LTM na prozor [7] Save AutoRecover o
P_assword to open:
Password to modify_:
podesite u desnom prozoru interval
automatskog snimanja (na primer 5 min).
|     Read-only recommended
Ukoliko unesete u prozor Password to open
neku šifru dokument će se otvoriti samo onda 
Cancel
Kada se ukuca šifra.
Ukoliko se unese u prozor Password to modify neka šifra, dokument će moći da menja samo onaj korisnik koji zna šifru.

FOOTNOTE (FUSNOTE)
[image: ]
Fusnota je primedba obeležena brojem, štampana sitnijem slovima u dnu strane. Obično su fusnote predstavljene brojevima iznad reči (na primer Marko Marković1)), a napomena (objašnjenje vezano za Marka Markovića) u dnu strane. Posle otkucane reči klikne se na Insert>Footnote. Otvara se sledeći prozor.
U njemu se definiše položaj fusnote (na tekućoj strani (©Footnote) ili poslednjoj strani (©Endtnote). Ukoliko je uključena opcija AutoNumber, svaka sledeća fusnota biće automatski numerisana. Klikom na OK računar Vas prebacuje na podnožje strane gde upisujete napomenu vezanu za markiranu reč.
NAPOMENA:
(U VERZIJI MS WORD 2003 FUSNOTE SE POZIVAJU NA INSERT > REFERENCE > FOOTNOTE)


[image: ]
SIMBOLS
Ova opcija omogućava unos nekih specifičnih znakova, sličica koje se ne mogu otkucati preko tastature. Na primer, ukoliko je potrebno otkucati Ø 125 mm, poziva se opcija Insert > Simbols. Računar pokazuje arhivu raznih znakova i simbola.
Klikom LTM na simbol, pa na Insert na mestu gde je bio kursor pojaviće se izabrani simbol.

[image: ]
AUTOCORRECT
Ova opcija omogućava da tekst
koji je dugačak i koji se ponavlja, bude
ispisan samo upisivanjem određenih
znakova.
Na primer, u tekstu se javlja često reč
otorinolaringologija. Pozivamo opciju
Tools > AutoCorrect.
Podesi se parametar kao na slici a
potom se klikne na Add.
Vaša kombinacija je ubačena u rečnik programa. Kliknite na OK i ukucajte sada reč orl. Potom kliknite na taster Spacebar (razmaknica) i pojaviće se reč otorinolaringologija.





HEADER & FOOTER
Ova opcija omogućava da se izradi u gornjem (Header) i donjem (Footer) delu stranice tekst koji će se, poput memoranduma, pojavljivati na svim sledećim stranicama istog dokumenta.
Klikom na View> Header & Footer računar otvara isprekidani prozor gde se upisuje određeni tekst. Otvaranjem gornjeg prozora, otvara se automatski i donji prozor za Footer.
Klikom na CLOSE na paleti koja se pojavi zatvara se opcija zaglavlja i podnožja, koje se zatim pojavljuje na svim stranicama dokumenta.
CIRKULARNA PISMA
Ovo je veoma korisna alatka, jer umnogome olakšava posao pri kreiranja tzv cirkularnih pisama kada se kombinacijom više dokumenata stvara treći.
Otvori se meni Tools > Mail Merge > Create (u kojoj formi–pisma, nalepnice ...) > Form letter > New Main Dokument (Novi glavni dokument) > Get Data > Create Data Source (kreiraj izvor podataka–adresar).
U Dialog Box–u vidi se da li adresar sadrži sva pitanja u vezi sa podacima jer lista može da se proširi pitanjima u adresaru (prazno Field polje u koje se upisuje naziv koji će biti u upitniku a zatim se dodaje na već postojeću listu (Add>>) na kraju se pritiska OK.
Računar pita gde da snimi novi adresar i ime (adresar prijatelja, kolega, pacijenata itd) > SAVE.
Klikom na dugme Edit Data Source (uređuj izvor podataka) pojavljuje se prozor u kojem se ispisuju imena i prezimena, poštanske adrese itd. Ne mora se popunjavati sve, samo ono što je potrebno da bude promenljiva.
Klikom na Add New dobija se novi blanko list koji treba popuniti novim imenom za adresar. Kada se unesu imena svih osoba, klikne se OK.
Na liniji sa menijima automatski se pojavljuje linija sa alatkama za INSERT MERGE FIELD.
Vreme je da se sastavi tekst.
Klikom na Insert Merge Field računar izbacuje spisak koji je ranije popunjen podacima (ime, prezime itd). Klikom na First Name računar na tom mestu u dokumentu automatski „ubacuje“ ime iz adresara. Naravno, korisnik određuje da li da ubaci sva imena, imena 1–10 sa spiska i sl. Klikom na Tools > Mail Merge > Merge > Merge računar stvara pisma sa iste sadržine ali namenjene različitim osobama.
Na primer:
Za gospodina << First Name>> << Last Name>>, (računar na svim dokumentima iz adresara stavlja imena i prezimena)...


NAPOMENA:
(U verziji MS Word 2003 cirkularna pisma se kreiraju na sličan način. Redom se klikne na sledeće komande: Tools > Letter and Mailings > Mail Merge > © Letters > Next: Starting Documents > © Use the curent Dociment > Next: Select recipient > © Type a new list > Next: Write your letter > Customize > (preko tastera Add, Delete ili Rename - dodaj, obriši ili prekrsti ime polja u obrazcu > (Popuni obrazac - sa New Entry dodati novi blanko obrazac) > Close > Sminiti bazu podataka > OK > Počnite sa kucanjem pisma - Poštovani .... > LTM na Insert Merge Field (ikonica) > LTM na First Name > Insert > Close > LTM na Insert Merge Field (ikonica) > LTM na Last Name > Insert > Close > LTM na Merge to New Document (ikonica) > OK.
KREIRANJE SADRŽAJA
Izrada sadržaja predstavlja odličnu alatku kada tekst ima veliki broj poglavlja i potpoglavlja kao i broj strana. Tada jednim klikom miša dobija se sadržaj sa tačnom numeracijom svakog poglavlja ili potpoglavlja. Pre toga treba kreirati simulaciju kao da se piše tekst koji ima nekoliko poglavlja.
Idemo sledećim redom:
· Otvorite Word dokument i na prvoj stranici napišite reč SADRŽAJ.
· Tasterom ENTER dođite do sledeće stranice tako da flešer bude na drugoj strani i upišite reč UVOD.
· Tasterom ENTER dođite do sledeće stranice tako da flešer bude na trećoj strani i upišite reč UVOD U RAČUNARE.
· Tasterom ENTER dođite do sledeće stranice tako da flešer bude na četvrtoj strani i upišite reč ISTORIJA RAČUNARA.
· Tasterom ENTER dođite do sledeće stranice tako da flešer bude na šestoj strani i upišite reč DELOVI RAČUNARA.
· Tasterom ENTER kliknite dva puta u upišite Hardver, a potom kliknite nekoliko puta taster ENTER u upišite Softver.
· Numerište sve stranice (INSERT > Page Numbers > OK)
· Markirajte reč UVOD.
· Pored linije gde se podešava font stoji linija na kojoj obično piše reč Normal. Kliknite na strelicu i sa palete izaberite HEADING 1.
· Ponovite postupak i sa rečima
UVOD U RAČUNARE, ISTORIJA RAČUNARA I DELOVI RAČUNARA.
· Markirajte reč Hardver, a potom sa linije na kojoj piše Normal izaberite HEADING 2.
· Markirajte reč Softver, a potom sa linije na kojoj je Normal izaberite HEADING 2.
· Kliknite LTM iza reči SADRŽAJ, a potom dva puta ENTER.
· Pozovite opciju INSERT > Index and Tables > Table of Contents (podesite parametre kao na slici) > OK.



[image: ]

· 
· TABLE (IZRADA TABLICA):
· Rad sa tabelama u programu Word je potpuno pojednostavljen. Kada se klikne na Table, jedina funkcija koja je aktivna na paleti alatki je Draw Table i insert Table. Klikom na nju otvara se prozor u kojem se definiše veličina tablice (broj kolona i redova)
· Number of columns (broj kolona) ili Number of rows (broj redova). Klikom na strelice \±\ ili 0 podešavate broj (veličinu Vaše tablice). Po definisanju broja kolona i redova kliknite OK. Na ekranu se pojavljuje tablična rešetka (5 kolona i 2 reda
· 
· [image: ]

Klikom na AutoFormat dobija se spisak vrsta tabela koje računar preporučuje.Posle definisanja broja kolona i redova u tablici treba kliknuti OK.
Po izradi tabele može se mišem podešavati (postavkom kursora na ivicu tabele dok se ne pojavi dvostrelični kursor («- 11 -►) koji pokazuje pravac pomeranja linije odnosno ivice tabele čime podešavate veličinu kolona ili redova).
Klikom na tablicu (LTM prevucite preko kolona ili redova čime ih markirate). Klikom
na DTM izbacuje se paleta alatki koja se može upotrebiti.
Pored standarnih Cut, Copy, Paste, Insert/Delete Rows ili Coloumns miš izbacuje i
opcije:
Alignment - (položaj teksta u ćeliji - u gornjem delu ćelije, na sredini ćelije ili dnu ćelije). Text Direction - reguliuše položaj teksta (upravan ili pod uglom od 90 °)

	Alignment (Top)
	Alignment (Bottom)

	
	


Tablica kreirana uz opcije DTM–Alignment, Text Direction
•    Insert columns/cell (ubaci kolone/ćelije) – markiranjem kolone ili više kolona proširuje se tablica dodatnim kolonama. Ukoliko se markira po redu, pojavljuje se opcija insert cell u Dialog Box računar pita šta tačno da ubaci i gde (ćeliju levo, desno, ceo red itd).
· Delete columns/cell (briši kolone/ćelije) – markiranjem kolone ili više kolona brišu se kolone tablice. Ukoliko se markira po redu, pojavljuje se opcija delete cell u Dialog Box računar pita šta da obriše (ćeliju levo, desno, ceo red itd).
· Merge cell (spoj ćelije) – jeste opcija kojom se, markiranjem dve ili više ćelija, dobija jedna ćelija.
Vaša tablica na početku	Vaša tablica posle Merge i split opcije
•    Split cells (podeli ćelije) – markiranu ćeliju računar će podeliti na željeni broj kolona ili redova.
NAPOMENA:
(U VERZIJI MS WORD 2003 TABELE SE POZIVAJU NA TABLE > INSERT   >
TABLE)





Umnožavanje
Mehanički postupak umnožavanja u repro-grafiji je umnožavanje sa opnenih matrica.
Elektrografija je skup postupaka a predložak se umnožava pomoću električnih sila. Elektrografija se koristi za izradu štamparskih formi štampanje faksimila i pri upotrebi grafičkih plotera. U elektrografiji se koristi i tečan i suvi toner, a gustina linija po jednom milimetru iznosi 20 - 80 linija


SENZIBILIZACIJA
elektroda za pisanje 


[image: ].

protiv elektroda formiranje slike

sloj izolatora podloga


Princip dobijanja latentne slikc u elektrografiji






Primenom novih elektroda moguće je izra-diti i višetonske originale. Ostale faze rada za dobijanje kopija (razvijanje, prenos slike, učvr-šćivanje slike i čišćenje) identične su fazama elektrografije,
Magnetografija je postupak umnožavanja koji za magnetisanje površinskog sloja na bubnju koristi struje niskog napona. Na namagnetisanim mestima bubnja prihvata se prašak (toner) koji se prenosi na papir a zatim fiksira (učvršćuje). Ovaj postupak se primenjuje najčešće kod štampača a ređe kod aparata za kopiranje .
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RAZVIJANJE
SENZIBILIZACIJA
kalem
magnetna glava namagnetisana površina
magnetno polje
čestice tonera
valjak za razvijanje
sloj koji se magnetiše
CISCENJE
[image: ]PRENOS
♦ • ♦*♦
L  I	četka za
-^	čišćenje
korona za prenos
Slika 267. - Princip magnetografije

Termografija je postupak umnožavanja pri ko-jem se koriste oslojeni materijali koji su osetljivi na toplotu, tj. infracrvene zrake.
Prilikom zagrejavanja grejnog elementa obo-jenje nastaje na podlozi osetljivoj na toplotu.
Termografija se primenjuje za štampanje fak-simila, voznih karata, kasa-blokova, označavanje roba, mernih i kontrolnih uređaja u indu-striji i medicini i za kopiranje dokumenata. Razlikuju se direktna i transferna (prenosna) termografija (sl. 268).
Elektrofotografija je postupak za umnožavanje dokumenata u jednoj ili u više boja, a danas se ovaj princip koristi i u savremenim digitalnim mašinama za štampanje. Bazira se na primeni poluprovodnika kao fotoosetljivih slo-jeva (selena i njegovih jedinjenja, kadmijum--sulfida, cink-oksida i dr.). Fotoosetljivi slojevi primaju visoki pozitivni električni naboj i za-državaju ga sve dok su u tami, a odvode taj na-boj kada se izlože svetlu. Na taj način se stva-ra elektrostatička latentna (nevidljiva, skrivena) slika.
Ako se kao fotoosetljiv sloj upotrebljava se-len (Se), kadmijum-sulfid (CdS), titan dioksid (TiO ) ili silicijum (Si) i njegova jedinjenja, go-vori se o kserografskom postupku kopiranja, i to suvi PTP (Povvder Toner process) i mokri LTT (Liquid Toner Transfer) postupak, a kada se upotrebljava cink-oksid (ZnO), radi se o elektrofaks postupku kopiranja, i to mokri EPC (Elektrofax paper copier) postupak (sl. 269 i 270).
Osnovni materijali koji se koriste za dobija-nje kopije su toneri (u prahu i tečni) i razvijači (developer i disperzant). 

obojenje .
[image: ]grejni element
sloj osetljiv na toplotu
papirna podloga

termopapir
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[image: ]DIREKTNA TERMOGRAFIJA (sa papirom sa nanetim slojem)
[image: ]
ABC
grejni element
TRANSFERNA TERMOGRAFIJA (na papiru bez sloja)
grejni element

papir
transferna folija

Slika 268. - Princip termografije


5. PRENOS SLIKE
1. PUNJENJE (DOVOĐENJE NAPO.NA)

[image: ]
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Glavna korona
3-,
Bubanj (PPS)
Bubanj (PPS)
Papir, fonja
Izvor	5"^
napajanja
Pritisni valjak
JEST
Bubanj (PPS)
6. CTSCENJE BUBNJA (PPS)
[image: ]Izvor
napajanja
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2. OSVHTLJAVANJH (EKSPOZICIJA)
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3. RAZVIJANJH
Bubanj (PPS)
[image: ]Radni rastvor (toner i disperzant)
Lopatica za cišćenje
Valjak za čišćenjc



Bubanj (PPS)
4. UKI.ANJANJE SUVISNOC RASTVORA
Skidačtonera    ■  ^verzibilni valjak (suprotnog smera)

	7. UKLANJANJE NABOJA
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Slika 269. - Princip elektrofotografije, mokri LTT postupak kopiranja
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Slika 270. - Aparat za višebojnu elcktrofotografiju
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[bookmark: _GoBack]PRITISNI VALJAK
PLOCAGREJACA
KORONA ZA TRANSFER-PRENOS
PODLOGA ZA KOPIRANJE
(PAPIR, FOLIJA) REVERZIBILNIVALJAK SA SUPROTNIM SMEROM OBRJANJA.
BUBANJ
VALJAK ZA UKLANJANJE SUVIŠNOG RAZVIJAČA SA TONEROM
VIDLJIVA SLIKA NA PPS *
RAZVIJAČ
SKIDAC
VALJAK ZA SKRETANJE
VALJAK ZA
ČIŠĆENJE
LOPATICA (BRISAC)
KORONA ZA; ČIŠĆENJE
[image: ]
PPS * NA BUBNJU
KORONA ZA UKLANJANJE NABOJA
PUT PODLOGE
KORONA ZA PUNJENJE  -.
ZA ČIŠĆENJE
PROCES RADA
4. Uklanjanje suvišnog rastvora
1. Punjenje, dovođenje napona (senzibilizacija)
2.	Osvetljavanje (ekspozicija)  5. Prenos slike
3.	Razvijanje slike	6. Čišćenje bubnja (PPS)*
PPS * - poluprovodnički spoj	7' Uklanjanje naboja

Slika 271. - Scma radnih faza dobijanja kopijc mokrim postupkom kopiranja (LTT)


SVETLOSNIIZVOR
SVETLOSNIIZVOR
KONTAKTNIPOSTUPAK
REFLEKSNIPOSTUPAK
[image: ]
[image: ]original sa prozirnom podlogom
fotopapir (fotosloj gore)
fotopapir (fotosloj dole)
original sa
refleksnom
podlogom

Slika 272. - Šema kontaktnog i refleksnog postupka fotokopiranja

Danas se uglavnom kopije dobijaju u crnoj boji, ali je uvođenjem no-ve tehnologije omogućena i izrada kopija u jed-noj od šarenih boja (monohromatske) i u više boja (panhromatske).
Višebojna elektrofotografija dobija se više-strukim uzastopnim formiranjem latentne slike na poluprovodniku kada se svaki put razvija to-nerom odgovarajuće boje ili se na poluprovod-niku formira višebojna slika pomoću raznih to-nera u boji, pa se u jednom koraku prenosi na podlogu i fiksira.
Dobijanje kopija u više boja je potreba koja zadovoljava specijalne zahteve, jer je njihova primena mnogostruka, i to: reprodukovanje ar-hitektonskih i inženjerskih crteža, crteža indu-strijskog dizajna, za marketing i reklamne agen-cije pod uslovom da su originali u boji i da se rade u ograničenom (malom) tiražu.
Dobijanje jedne kopije elektrofotografski u principu čine sledeće faze:
1) punjenje, dovođenje napona (senzibilizacija),
2) osvetljavanje (ekspozicija),
3) razvijanje slike,
4) uklanjanje suvišnog rastvora,
5) prenos slike,
6) čišćenje bubnja i
7) uklanjanje naboja.
Jednostavnost i brzina dobijanja elektrosta-tičke kopije omogućuju da se elektrofotografski princip kopiranja koristi za izradu papirnih i plastičnih formi za mali ofset.
Fotokopiranje ]e postupak dobijanja kopija na fotografskom materijalu - fotopapiru. Fotopa-
pir sadrži svetloosetljiv sloj, koji se sastoji od sre-bro-halogenida, želatina i zaštitnog sloja. Kod fotokopiranja razlikuju se više postupaka od ko-jih su najpoznatiji optički, negativ-pozitiv, difu-zni i verifaks-postupak. Kopije su veoma oštre i kvalitetne, ali se zbog komplikovane izrade ko-pija ovaj postupak slabo koristi (sl. 272).

Heliografija ili svetlosno kopiranjc predstavlja postupak umnožavanja originala pomoću jakog izvora svetlosti (sl. 273). Umnožavanje na ovaj način radi se kontaktnim kopiranjem originala, koji je izrađen na prozirnoj podlozi, i materijala na kome se kopira, a koji je oslojen dijazoslojem (sl. 274). Ovaj način umnožavanja je jeftin i jednostavan i služi za izradu kopija crteža ve-likih formata. Postupak se sastoji iz dve faze ra-da: 1) osvetljavanja i 2) razvijanja. U zavisnosti od načina razvijanja, postoje suvi, mokri i ter-mički postupak.
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Umnožavanje sa opnenih matrica
Najrašireniju vrstu reprografskog umnoža-vanja predstavlja umnožavanje sa opnenih ma-trica. Opnene matrice se dobijaju mehanički (kucanjem na pisaćoj mašini - voštane matrice) i elektronski - kopiranjem na specijalnim ure-đajima progorevanjem sloja dielektrikuma - pa-pirne i plastične matrice (sl. 276).
Elektronski aparat za izradu opnenih matri-ca sadrži mehaničke i elektronske delove i na njemu je moguće izraditi - snimiti sve vrste ori-ginala do formata A4. Tiraž snimljenih matrica je i do 15000 primeraka.
Umnožavanje sa opnenih matrica, izrađenih, na jedan od navedenih načina obavlja se na apa-ratima koji se nazivaju opneni umnoživači - ge-štetneri (sl. 277).
Opneno umnožavanje je najstariji postupak kancelarijskog umnožavanja. Na opnenim umnoživačima se izrađuju razni radni materi-jali (pozivi, zapisnici, sporazumi, elaborati, pro-jekti, skripta i dr.).

indikator za skaniranje
mesto za
postavlianje
originala
beli prekidač za uključenje
poklopac aparata
merac napona
mesto za postavljanje opnene matrice graničnik za skeniranje filter birać brzine
[image: ]Slika 275. - Aparat za svetlosno kopiranje i princip dobijanja kopije
[image: C:\Users\mcns\Desktop\mala_3220.jpg]
Multifunkcionalni kolorni fotokopir (printer)
KORISNIČKO I TEHNIČKO UPUTSTVO ZA UPOTREBU

(primer)
SPECIFIKACIJA I TEHNIČKE KARAKTERISTIKE 
Kopir:
-lasersko skeniranje i elektrofotografsko štampanje -brzina kopiranja, crno belo i kolor 25kopija/minut -rezolucija 600 dpi -višestruko kopiranje do 999 -period zagrevanja manji od 45 sekundi -prva kopija crno bela 6.7 sekundi -prva kopija full kolor 9.7 sekundi -memorija standardna 1024MB+40 GB Hard Disc Drive -kapacitet kaseta za papir standardni 2x500 listova -kapacitet izlaza papira maksimum 1500 listova -dimenzije papira A6-A3(A3+ preko by pass kasete) -gramaže papira, kaseta 60-216 g/m2 -gramaže papira, bvpass 60-257 g/m2 -gramaže papira, duplex 64-169 g/m2 -dimenzije aparata 650x659x740mm -težina aparata manja od 120 kg sa ARDF-om -izvor napajanja 220-240 V, 50/60 Hz -potrošnja električne energije u radu 1 5kW u energy saver modu 99W i u auto off modu manje od 8W
Printer:
-brzina štampanja crno belo i kolor 25 kopija/minut -printer jezik standardni PCL5c,PCL6,RPCS™ -rezolucija 600x600 dpi/2400x600 dpi (equivalent) -interfejs standard USB 2.0 i Ethemet 10 base-T/100 base-TX -mrežni protokol TCP/IP, IPX/SPX, Apple Talk -podržana okruženja Windows 65/98/Me/NT4.0/2000/XP/ Server 2003
Skener:
-brzina skeniranja maksimalno 50 strana/minut (MH.A4) -rezolucija maksimalno 1200 dpi (1200dpi TWAlN black and white, greyscale) -veličina originala A5-A3 -Izlazni formati PDF/JPEG/TIFF/High compression PDF
Softver:
-SmartDevice Monitor™ -Web -SmartDevice Monitor" -Web -Image Monitor -DeskTopBinder™Lite

POSTAVLJANJE ORIGINALA ZA KOPIRANJE
Originali se mogu postavljati na dva načina, jedan od načina je da se original postavi direktno na staklo, a drugi je u ARDF(automatski povlakač papira).
LPostavljanje originala na staklo
[image: ]
Original se postavi tekstom na dole u gornji levi ugao, pri tom se mora voditi računa da obe ivice papira budu postavljene tik uz graničnike (lajsne).
2.Postavljanje originala u ARDF (automatski povlakač papira)
[image: ]
Original se postavi u ARDF tekstom na gore (slika gore) vodeći računa da se graničnici postave uz ivice originala (slika gore br.2). Prilikom rada sa ARDF-om originali koji se postavljaju ne smeju biti zaheftani, oštećeni-pocepani i moraju biti propisanog formata. Treba voditi računa da se originali koji su prepravljani korektorom ne stavljaju u ARDF.

OSNOVNA PROCEDURA RADA SA APRATOM OSNOVNE KOMANDE




		
1. Podešavanje kopije (boje, moda, kontrasta)
2. 0peratorski status i displej za poruke
3. Podešavanje veličine kopije
4. Status broja originala i kopija u toku kopiranja
5. Podešavanje oblika kopija (jednostrano na dvostrano, dvostrano na dvostrano...)
6. Podešavanje sortiranja i heftanja kopija
7. Trenutno dostupne funkcije za rad sa aparatom
8.Funkcija koja je trenutno odabrana
Posle željeno odabranih funkcika i unetog broja kopija početak kopiranja se vrši pritiskom na taster start .


OSNOVNI EKRAN(TOUCH SCREEN) ZA KOPIRANJE
Ekran kod ovog aparata je dizajniran tako što svi njegovi delovi reaguju na dodir i time se odabiraju željene opcije(podešavanja) vezana za fotokopiranje. Ekran je podeljen u više segmenata tako što je svaki segment vezan za određenu grupu podešavanja (odabir kaseta za papir sa formatima, podešavanje veličine kopije, podešavanje kontrasta kopije, podešavanje sortiranja i heftanja, podešavanje boje kopije crno belo ili kolor...) Takođe displej ima i ostale funkcije od kojih je jedna da obaveštava korisnika o statusu aparata(nalazi se na gornjem delu dislpleja). Obaveštava korisnika da li je aparat u operacionom režimu i o statusu broja kopija koje se ternutno kopiraju i koliko je još originala ostalo da se kopira. Na displeju se ispisuju i sve moguće greške aparata tako što se generišu u trocifren broj sa prefiksom "SC'.Uz broj greške aparat ispisuje na displeju da je potrebno pozvati servis da bi se kvar otklonio. Greške pomažu serviserima zato što je svaki broj greške vezan za određenu sekciju i samim tim dijagnostikuje i tačno određuje kavr i dovodi do njegovog lakšeg otklanjanja.

GLAVNI DELOVI APARATA
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1.	Exposure glass cover (opfional) 01
Auto Documenl Feeder (ADF) (op-
tional)
Poklopac eksooziconog stakla u standardnoj varijanti u opcionoj vanjanti ADF-automatski povlakač papira. (Aparat se sporucuje bez ADF-a, ADF- se dobija opciono.
2.	Exposure glass
Ekspozic ono staklo na koje se polaže original u gonji levi ugao.
3. Izlazni putza kopije.
4. Main po\ver switch
Glavn prekidač fotokopir aparata za uključeno/isključeno. (Glavn prekidač mora biti uključen da bi aparat bio u stand by modu
5. Main power indkator 
Indoikator glavnog preidača. Inclkator pokazuje da je aparat uključen u stand by modu.
6. On inlicator
Indikator za uključen aparat
lndikator poozuje da je aparat uključen i da je u operacionom rezimu.

Operation switch
Operacioni prekidač  pritiskom na ovaj prekidač. kada je ukljjčen glavni prekidac. stavljamo aparat iz stand by mode u operacioni mod. Aparat je spreman za rad
8. Control panel
Kontrolna tabla
9, Internal tray 2 (1 bin tray) 
Izlazni put za kopije. Ne isporucuje se u standardnoj varijanti dobija se kao opcija.
10 Duplex unit dupleks jedinca za dvostrano kopiranje (opciono
11 Front cover
Prednja vrata.
12. Paper tray
Kasete za papir gornja i donja kaseta.
13, Paper tray unit (kaseta za papir dobija se opcionu) 
14, Holding stand postolje
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1. Bupass tray
Prostor za ručno ulaganje papira. Kada ne želimo da se uzima papir iz kasera koristimo ovu funkciju.
2 Right sidc cover
Desna vrata (otvoriti kada je papir zaglavljenj.
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7. Ventitation holes
Prostor za ventiaciju aparata. 
Voditi računa da se neki predmeti ne bi stavili blizu ovog prostora jer bi tada dočlo do zagušenja ovog prostora i aparat ne bi imao ventilaciju.

Osnovni tasteri
Tasteri koje koristimo za osnovne funkcije. ♦ Lista tastera

	[OK]
	Potvrda izabrane opcije
Pritiskom na taster potvrđujemo operaciju koju smo izabrali

	[Cancel]
	Brisanje unetog broja za pojedine funkcije, poništavanje izabrane operacije i povratak na prethodnu

	[Prev] [Next]
	Taster za kretanje gore-dole na displeju, kada izabrana opcija ne može biti prikazana na jednoj strani

	[OK] [Yes]
	Zatvaranje unetog broja za pojedine funkcije.

	[Clear]
	Brisanje unetog broja za pojedine funkcije

	[Exiit]
	Povratak, izlazak u prethodni meni


Dodirom na ikonicu. selektujemo operaciju koju ikonica izvršava
KacJa smo seiektovaii operaciju ikonica mora biti sa tamnom poo^ogom kao
IB     Kao na ovoj shci	ikonica nije odabrana i trenutno rsena funkciju

PODEŠAVANJA KOPIJA U PROCESU FOTOKOPIRANJA
PODEŠAVANJE KOLORA
Tasteri služe za podešavanje kolora u procesu fotokopiranja "Auto Colour Selecf-automatsko odabiranje boja "Full Colour"-pun kolor "Black&White"-crno belo
PODEŠAVANJE MODOVA KOPIJE
Tasteri služe za odabir modova u procesu fotokopiranja u zavisnosti od toga
šta se fotokopira.
"Texf-mod koji se koristi kod kopiranja teksta
"Photo"-mod koji se koristi kod kopiranja fotografija
"Text/Photo"-mod koji se koristi kada kopija sadrži i tekst i sliku
"Others"-modovi za ostala kopiranja
PODEŠAVANJE KONTRASTA KOPIJE
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Tasteri služe za podešavanje kontrasta kopije u odnosu na original.
"strelica na levo"-svetlija kopija
"strelica na desno"-tamnija kopija
"Auto Density"-automatsko podešavanje kontrasta
ODABIR KASETA SA FORMATIMA PAPIRA
        
   A4    A4 : A3    A3 
"AutoPaperSelecf-automatski odabir kasete "1 A4"-kaseta poprečnog formata A4 "2 A4"-kaseta uzdužnog formata A4 "3 A3"-kaseta A3 formata "4 A3"-kaseta A3 formata "Bypass"-ručna kaseta za papir

PODEŠAVANJE VELIČINE KOPIJE - MENJANJE FORMATA


"Full Size"-originalna veličina (100%)
"AutoReduce/Elarge" - automatsko podešavanje veličine kopije
"A3—>A4 i A4->A5" - prebacivanje formata A3 na A4 i A5 na A4 format
(umanjivanje)
"A4—>A3 i A5-^A4" - prebacivanje formata A4 na A3 i A5 na A4 format
(uvećavanje)
"93%"-umanjivanje originala sa 100% na 93%
Takođe je moguće pomoću opcije"ZOOM" vršiti fino umanjivanje ili
uvećavanje po 1%.
KOMBINOVANJE ORIGINALA


"slika 1" - kombinacija dva jednostrana originala na dvostranu kopiju
"slika 2" - kombinacija dvostrani original na dvostranu kopiju
"slika 3" - kombinacija dva jednostrana originala na jednostranu kopiju
"slika 4" - kombinacija dva jednostrana originala u dva primerka na jednostranu kopiju
"slika 5" - kreiranje margina na kopiji
PODEŠAVANJE SORTIRANJA I POZICIJE HEFTANJA KOPIJA

Kada je uključena opcija heftanja, aparat ne sortira kopije.Naime, kopije se fizički mogu odvojiti, one su uheftane po broju kopiranja u odnosu na skenirane originale.


"slika 1 "-sortiranje kopija po seriji originala (original 1,2,3,4, kopija 1,2,3,4)
"slika 2"-sortiranje kopija po originalu pojedinačno (original 1,1,1,2,2,2,3,3,3,
kopija 1,1,1,2,2,2,3,3,3)
"slika 3"-pozicija heftanja u gorhji levi ugao (nebitno koji je format i kako je
orijentisan)
"slika 4"-pozicija heftanja u donji levi ugao (nebitno koji je format i kako je
orijentisan)
"slika 5"-pozicija heftanja na dva mesta sa leve strane (nebitno koji je format
kako je orijentisan)
"slika 6"-pozicija heftanja na dva mesta sa gornje strane (nebitno koji je
format i kako je orijentisan)

OPCIJA PAUZIRNJA U TOKU KOPIRANJA DA Bl SE HITNO ISKOPIRAO NEKI MATERIJAL
Ako se kopira jedan materijal u više primeraka, a postoji potreba za hitnim kopiranjem drugog materijala u 1 ili 2 primerka, koristi se pauza kopiranja, iskopira se ono što je hitno a zatim se nastavlja sa kopiranjem prekinutog.
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Postupak prilikom pauziranja:

-pritisnemo taster "interrupt" (označen na slici gore)
-uklonimo originale koji se kopiraju
-ubacimo novi original
-pritisnemo taster "start"
-nakon kopiranja izvadimo original i iskopirane kopije
-vratimo prethodne originale
-pritisnemo taster "interrupt" (označen na slici gore)
-pritisnemo taster "start" za nastavak kopiranja
PROVERAVANJE UKUPNOG ODRAĐENOG BROJA KOPIJA
Aparat ima digitalni brojač kopija, koji pokazuje koliko je kopiranih primeraka i odštampanih dokumenta.
Postupak pri proveri broja kopija

-pritisnite dugme "User tools/Counter" (slike gore).
-pritisnete opciju "Counter"
-ako želite da odštampate broj kopija, pritisnite opciju
"Print Counter List" –pritisnite taster "Start"








Биро-дорада

Наставна jединица: Подела графичке производње

Графичка дорада је део целокупног технолошког процеса у коjeм 
производи графичке индустрије добијају коначан облик.Ова делатност
обухвата завршне процесе, средства и припрему у штампарској производњи 
и операције ручног и индустријског повеза књига, претварање папирних
величина у просторне облике кутија, те уопште прераду и дораду папира,
фолија, картона и лепенке. Из штампаних табака се у процесу графичке 
дораде повезују књиге, равни се облици табака картона и лепенки претварају у просторне облике (кутије), из линираног се папира производе бележнице.
Технолошки процес графичке дораде се може класификовати на следећа 
Подручја:
1) Књиговезачка дорада је производни погон у којем се масовно производе различити повези. Томе припада и одељење галантеријом,у којем се полуиндустријским и индустријским начином производе квалитетнији повези мапа и каталога, албума за слике и марке, појединачни повези за изложбе итд... Опрема корица се врши најчешће златотиском и штампом фолијама. Књиговезачка дорада је производни сектор у којем се одштампани табаци, одштампане ролне папира и остали материјали прерађују у књиге, брошуре, часописе, новине, каталоге, блокове, проспекте, акциденичне радове итд...
Графичка дорада обухвата завршне процесе, средства и припрему у штампаркој производњи, укључујући и операције индустријског и ручног повеза књига, претварање папирних величина у просторне облике кутија, уопштено прераду и дораду папира, фолија, картона и лепенки.
Задатак графичке дораде јесте да све папирне величине преради и доради до коначно употребног облика. 
Из штампаног табака у процесу графичке дораде повезују се књиге, из равног табака од картона и лепенке праве се кутије .
Основна сировина графичке дораде је папир, укључујући картон и лепенку са могућим додатцима пластичних и алу фолија, лакирање на импрегнираним и пластифицираним површинама.
Књиговезачка дорада је производни сектор графичке дораде у којем одштампани табаци прерађују у књиге и брошуре. Књиговезачка дорада се дели на ручну и машинску.
У ручној књиговезачкој доради повезују се поједини примерци књига и мали тиражи књига. Такође у књиговезачкој доради израђују се и специјални производи ( албуми, писаће мапе, каширају слике, украшавају папири за пресвлачење књиге), као и неки картонажерски производи (кутије за књиге, футроле за дипломе, кутије за прибелешке). Врхунац књиговезачког ручног рада су рестуарација и конверзација старих рукописа и књига, као и израда специјалних повеза у кожи и пергаменту. Одавде долази до изражаја смисао за уметнички рад јер повез, пресвлаку, предлист и наслов на корицама треба обликовати у складу са садржајем књиге. Ручним повезом могу се повезати велики тиражи књига, задовољити кратки рокови испоруке, економичност и уједначеност квалитета.
У индустријској доради машине преузимају највећи део операција рада, па се књига, брошуре, каталози, проспекти, календари, телефонски именици и друго повезују масовно на високопродуктивним машинама и линијама за повез.

Наставна Јединица: Појам графичке производње
Графичка индустрија је део индустрије који се бави израдом штампарских производа.
Графичка дорада је завршна фаза графичке производње у којој графички производи добијају свој коначан изглед.
За израду разних производа користе се и машине које могу бити:
1. Ручне
2. Полуаутоматске
3. Аутоматске 
Графичка дорада обухвата:
1. Књиговезачку дораду
2. Производњу амбалаже и картонаже
3. Прераду папира
Књиговезачка дорада је фаза графичке дораде у којој се оштампани табаци прерађују у књиге и брошуре, као и специјалне производе.
Амбалажа је збирни појам који обухвата средства за паковање (кутије, кесе, вреће и др), различитог облика и величине, направљене од папира, равног и таласастог картона, лепенке, полимерних фолија и др.
Картонажа је назив за средства за паковање израђена од картона и пуне лепенке. Најважнији производи картонажерске дораде су кутије.
Прерада папира - бави се израдом различитих производа од папира, картона и лепенке. Прерада папира обухвата производњу штампане амбалаже, израду коверата, школских свезака и др. 

РЕЗАЊЕ ТАБАКА	

У књиговазачкој доради под резањем се подразумева раздвајање материјала равним или округлим ножем. Техником резања различити материјали (папир, картон, лепенке, пресвлачни материјали и др) и производи књиговезачке дораде (књижни блокови, брошуре, часописи и др) изрезују се на одговарајућу величину.
Основни принципи који се користе код мануелних или ручних техника резања нашли су примену и код различитих машина за резање ножем и маказама.
Резањем ножем примењује се за сечење табака, обрезивање свезака и књижних блокова за бешавни и тврд повез.
Резањем маказама примењује се за резање појединачних материјала папира, картона, лепенке, пресвлачних материјала и за обрезивање брошура.
Основни појмови резања су:
-рез за изједначавање(угаони рез)
-разрез и обрез.
Машина за резање папира је основна машина графичке дораде и има важну и незаманљиву улогу у току израде графичког производа. Кроз њен циклус производње пролази сав штампани и нештампани материјал који се у даљим фазама претвара у финални – готов производ.
Ове машине се међусобно разликују по степену аутоматизације и по дужини резања.
Постоји три врсте резања:
1. Обрез
2. Прирез
3. Разрез или изрез
Машине за резање се састоје:
1. Масивно ливено постоље - даје стабилност на шини и носи остале делове.
2. Једноделна радна плоча - глатка површина смештена је на одговарајућу висину. Једна трећина радне површине налази се с предње страна, једнаке површине лево и десно. 
3. Клизна греда покреће навојна осовина и аутоматски се помера напред и назад. Служи као наслон за табаке и гура их напред.
4. Носач ножа - усмерава носач укосо, лево или десно према доле или горе, у случају оптерећења уграђен је сигурносни тастер.
5. Ножеви за сечење - састоје се од два дела: држач оштрице ножа и оштрице. Ножеви су израђени од челика - видиа. Оштрица ножа је залемљена на држач. Ножеви се мењају када се иступе и носе се на поновно оштрење.
6. Притисна греда има задатак да притисне материјал на подлогу да се он у току резања не би помакао
7. Сигурносни уређаји спречавају подметање руку под резну површину док нож ради, савремени ножеви имају фотоћелије које при непажњи и стављању руку прекине светлосни сноп фотоћелије истог тренутка зауставља се нож. Да би се нож покренуо,  потребно је притиснути два дугмета са обе руке.

РУЧНО САВИЈАЊЕ ТАБАКА	`
Савијање значи отворене формате табака по унапред утврђеној схеми једном или више пута превијати са оштрим ивицама. Поред оштрих ивица и превоја без фалти при савијању важну улогу имају распоред страница и регистар текста савијеног табака.
У зависности од односа ширине и дужине савијеног табака, разликују се уздужни, попречни, квадратни, издужено-попречни, издужено-уздужни облик графичког производа.

Класификација штампаних и савијених табака

У књиговезачкој доради под појмом табак подразумева се јединица за обим (садржај) књижног блока књига и брошура.
Полазна јединица је основни табак од 16 страница.
Штампани табак је табак папира одређене величине на коме је извршено отискивање(штампање).
Савијени табак је штампани табак или табак папира савијен на величину графичког производа (књига, брошуре, часописа и др.)
Врсте савијања
Разликују се, углавном, три врсте савијања:
1) Унакрсно
2) Паралелно
3) Комбиновано
Унакрсно савијање подразумева савијања дуже стране табака, превоји су нормални( под правим углом) на претходни превој.
Паралелно савијање подразумева такво савијања при којем су у превоји међусобно паралелни. Постоје четири врсте паралелног савијања и то су:
-чисто паралелно
-неизменично паралелно
-намотано паралелно
-фенстер фалц
Комбиновано савијање је такво савијања табака да се комбинује комбиновано паралелно и унакрсно савијање.
Све наведене врсте савијања табака могу се радити ручно и  машински.
Ручно савијање табака ради се помоћу коштаног или дрвеног савијача којим се обликује оштар превој савијеног табака.

МАШИНСКО САВИЈАЊЕ ТАБАКА

Машинско савијање табака обавља се помоћу машина за савијање табака код којих се разликују два принципа савијања:
1. Савијање ножевима
2. Савијање џеповима
На основу ова два принципа савијања у пракси постоје три врсте машина за савијање:
1. Машина за савијање ножевима
2. Машине за савијање џеповима
3. Машине за савијање џеповима и комбиноване машине за савијање.
Поред савијања табака, машине за савијање имају и додатне уређаје за перфорисање табака, биговање табака, сечење табака, лепљење табака и др. Изабрана операција обавља се континуирано у току процеса савијања.

САКУПЉАЊЕ ТАБАКА

Под појмом сакупљање у књиговезачкој доради подразумева се комплетирање (израда) књижног блока одређеним редоследом неког графичког производа(књиге, брошуре, блокови, календари и др) од појединих савијених табака или листова. Тачан редослед књижних табака за сакупљање одређује се помоћу ознаке стране (пагинација), примарне сигнатуре и контролног знака. 
За сакупљање савијених књижних табака постоје два технолошка поступка:
1. Техника сакупљања табака у табак
2. Техника сакупљања табака на табак
Тачност редоследа сакупљених књижних табака у оквиру једног књижног блока визуелно се контролише помоћу ознаке на превоју табака - контролног знака.
Сакупљање табака у табак обавља се најчешће код производа чији број табака не износи више од 6 тј. Зависи од врсте производа, граматуре и волумизности употребљеног папира. Сакупљање табака у табак ради се за мање тираже ручно, а за веће количине брошура и часописа обавља се на машинама за сакупљање табака у табак и шивење жицом кроз превој.
Сакупљање табака на табак је најчешћи начин израде књижног блока у књиговезачкој доради и ради се код производа са већим бројем табака.


РУЧНО САКУПЉАЊЕ ЛИСТОВА

Разликује се ручно и машинско сакупљање табака на табак и машинско сакупљање табака на табак.
Листови се сакупљају за израду брошура, блокова, календара, повеза са пластичним и металним спиралама и повеза са механизмом, тј. свих производа где се књижни блокови састоје од слободних листова. Поједини листови могу да се сакупљају ручно и на специјалним машинама за сакупљање листова.

ШИВЕЊЕ ТАБАКА

Шивење је поступак у књиговезачкој доради којим се спајају поједини књижни табаци, логови или листови материјалом за шивење у књижни блок (књига, брошура). Зависно од примењеног материјала, разликује се:
1. шивење жицом
2. концем.
3. шивење термоконцем
Поред шивења жицом и концем, постоје и други начини за спајање табака, логова или листова у књижни блок и то: повез лепљењем ( бешавни повез) и механички поступци повезивања (спирале, механизми, шине и др.).
Шивење жицом - ради се на хефт - машини, односно на машини за шивење жицом кроз превој и поред превоја. Шивење жицом кроз превој ради се шивењем једног или више сакупљених табака у табак или логова кроз повежљак, а користи се за шивење часописа, свезака и тањих брошура.
Шивењем жицом поред превоја ради се шивењем одозго тј. нормално на повежњак неколико милиметара удаљено од ивице повежњака. Користи се за шивење блокова и дебљих брошура. Код оваквог шивења приликом отварања књиге листови се не отварају потпуно већ се појављује ефекат „кламера“.


ШИВЕЊЕ ЖИЦОМ	`

Шивење жицом се ради специјалним машинама које се могу поделити на следеће групе:
· машине за шивење жицом за брошуре и блокове
· машине за шивење жицом у картонажи
· машине за шивење жицом књига кроз тул-платно
· машине за шивење жицом кроз превој при сакупљању табака у табак
· комбиноване машине за шивење, савијање и обрезивање
· машине за шивење комбиноване са рото-машинама за штампање
основни заједнички елементи за све ове машине је кламер (спојница) која служи за спајање табака или листова у књижни блок.
Процес израде кламера у машини за шивење жицом састоји се од пет фаза:
1. вођење жице од калема
2. резање жице на величину кламера
3. формирање кламера 
4. пробијање кламера кроз материјал за шивење
5. повијање крајева

Врсте шивења жицом
У пракси се сусрећу следеће варијанте шивења жицом:
· шивење жицом кроз превој
· шивење жицом поред превоја
· шивење жицом у картонажи

ВРСТЕ ПОВЕЗА

У графичкој доради постоји подела графичких производа према начину израде:
· Једноставни несавијени производи 
· Производи добијени савијањем
· Производи добијени повезивањем
· Остали производи графичке дораде

Производи добијени повезивењем деле се на:
· Блокове
· Брошуре
· Тврд повез
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